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Release Note – by Pixel Magic Systems Ltd. 

 
 
Crystalio II Release Note 
 
Version 2.10 
 
- Added global profile Store/Recall from front panel Profile->All Profile. It will 
Recall/Store the same number of Input/Image/Output profile 
- Added SD/HD-SDI manual selection on VPS3800 from front panel Input-
>Port Config->SDI1/2 Format->Auto/SD/HD 
- Added front panel Output->24p Frame Lock OFF/ON to enabled “Frame 
Lock” on 24p HDMI Input. Disable “Frame Lock” on other Input format 
- Fixed HDMI Output AVI Info Frame bug to correctly report the color space 
(RGB/YCbCr) and color matrix (bt601/709) format 
- Fixed HDMI Output YCbCr PC Level (0-255) conversion bug 
 
Version 2.08 
 
- automatic frame locking when output refresh rate is exact multiple of input 
- improved analog input signal detection 
- improved HDMI output plug change detection and signal stability 
- optimized handling of input signal color space change (BT601/BT709) 
- associated screen shape stored with each customized resolution 
- adjustable Output R/G/B Gain, Offset, and Saturation 
- Added input/output color space and video level detail in OSD information 
page. 
- Accept both <CR> (carriage return) and <LF> (line feed) character as line 
terminating in RS232 command protocol to improve compatibility with various 
terminals and control systems 
 
Version 2.07 
 
- Faroudja DCDi color issue occasionally appear on some units resolved 
- Bug fixed: unstable analog output of 1080i@50Hz, 480p, or 576p in 
YPbPr color space 
- Bug fixed: problem of detecting input signal color standard (BT.601 
or BT.709) 
- Bug fixed: some customized resolution which may result in unstable 
output 
- Bug fixed: after recalling an output profile, some settings may not 
be  
 
Version 2.06 
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This firmware improve the image "tearing"/breakup issue when  
 
- Input image at 16x9 LBX 2.35:1 and  
- Output screen shape at 2.35:1 and 
- output refresh rate at 47.95Hz and 
- source format is in 3/2 pulldown cadence lock ON 
 
If the playback becomes "stutter" or tearing occur, please try to fast 
forward/backward the playback a bit or do a chapter skip to restore the correct 
motion. 
 
Other change and fix in the firmware are: 
- improved internal FTP server tp support large file (>4GB) (for models with 
internal media player only) 
- No signal blue screen color will follow the setting in 
[Output]->[Screen Masking]->[Mask Layer Color] 
- Image gamma settings not applied on internal test patterns 
- "PIP/PBP profile recall" added into front panel command 
- bug fixed: using macro key to switch input, video profile with secondary 
pass-through settings defined may not applied automatically 
- bug fixed: problem of import settings with long user defined names using the 
20th characters 
- bug fixed: DynamicVP Otherwise cause execution problem 
- bug fixed: PIP/PBP OSD page, button gray out problem 
 
Version 2.01 
 
- Status Message top-left popup On/Off  
  (inside OSD page "OSD Option" of "System" sub-menu) 
- Restart System from OSD 
  (inside OSD page "Factory Settings Reset" of "System" sub-menu) 
- DynamicVP new conditions: 1080p24sf, 1080p24, 1080p50, 1080p60 
- DynamicVP message boxes changed to top-left status messages 
- Adjustable "3D Comb Filter" for SD processing 
- Adjustable "Dot Crawl Filter" for SD processing 
- Adjustable "Chroma Filter" for SD processing 
- Added slide bars for adjusting parameters of Faroudja TrueLife  
- Quick menu for profile selection shows profile name if defined 
- RS232 command set updated  
  (e.g. PIP/PBP settings, status message on/off, settings of filters) 
- When inputting HD signal from SDI port, LCD/OSD shows input port as 
  "HD-SDI 1/2" instead of "SDI 1/2" 
- Minor bug fixes (export settings, DynamicVP condition selection menu) 
 
Version 2.00 
 
1. Picture In Picture / Picture By Picture (* see notes below) 
2. Macro commands for PIP/PBP 
3. Import/Export settings of PIP/PBP 
4. Customizable 1080PsF output timing 
5. Macro command for setting 1080PsF output 
6. Enhanced HDMI audio handling 
 



 3 

* Notes on PIP/PBP 
 
- When in Picture in Picture (PIP) mode, there is a small sub-picture 
   on top of the main picture, which comes from another video source. 
   User can adjust the position, size, overscan, transparency, and crop 
   of the sub-picture. 
- When "crop" or "overscan" is independent, the "crop"/"overscan" 
   value set in Image menu is ignored; when "crop" or "overscan" is 
   additional, value set in Image menu and here are combined 
- When in Picture by Picture (PBP) mode, main picture is shifted to 
   the left side of screen and a sub-picture, which comes from another 
   video source, appears in the right side (they are side by side) of 
   screen. User can adjust the position of the line splitting the main 
   and sub-picture, position, overscan, transparency, and crop of the 
   sub-picture 
- Main picture and sub-picture can not come from 
   . HDMI1 and HDMI2, or 
   . HDMI3 and HDMI4, or 
   . SDI1 and SDI2, or 
   . Component1 and Component2, or 
   . Any two of Component3, Component4, S-Video 1/2, Video 1/2/3/4 
- Sub-picture retains the same image aspect ratio defined as when it 
   is primary video source. Except that it appears as 4:3 in PIP/PBP 
   sub-picture if it is defined as "Natural NLS" when it is primary 
   video source. 
- Crystalio applies normal deinterlacing method in Main picture (VXP 
   or DCDi as defined in the main video source), but only use simple 
   BOB deinterlacing in sub-picture. However, one exception case is 
   that if main picture is defined as VXP deinterlace while sub-picture 
   is defined as DCDi, Crystalio will apply DCDi to the sub-picture 
- If main picture and sub-picture come from the same source, and it is 
   defined as DCDi deinterlace, Crystalio will use VXP deinterlace in 
   main picture and DCDi in sub-picture 
- When in PIP or PBP mode, secondary passthru has no effect 
 
 
* Bug Fixed 
 
- HDCP problem when cadence lock mode changes 
- Video level problem of VXP converting from 0-255 RGB to YCbCr 
- Vertical color banding problem when boot up with internal media player as 
initial input port (3800 only) 
- HDMI input flash problem when setting audio path 
- RGBS problem of Component 3/4 input 
- Resolution name may changed when replacing a modified resolution 
- Occasional color error when using DCDi 
- HDMI input port switching problem 
 
Version 1.30 
 
NEW FEATURES 
1. Cadence Lock of film 3:2 source to 2:2 or 3:3 output enabled, for 
   the following input ports: 
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   - HDMI 1/2/3/4 
   - SDI 1/2 
   - COMPONENT 1/2 
   - Internal Media Player 
 
   note: to enable Cadence Lock feature, set output format/resolution 
   to one of the followings: 
   - resolution with refresh rate of 47.95 or 71.93, e.g., 
     1920x1080@47.95 
   - customized resolution with refresh rate of 47.95 or 71.93, 
     i.e., enter 4795 or 7193 in the refresh rate input box 
   - 1920x1080P24sF 
 
   known issue: 
   - Cadence Lock may not work with 
     . Letterbox source AND 
     . Output screen shape is wider than the source 
     For example, 16:9 letterbox source AND 2.35:1 output screen shape 
   - Cadence Lock may not work well when input signal timing is not 
     stable; when that happens, a "jump" with the source movie (e.g., 
     fast forward, next chapter, pause then play, etc.) may help to 
     resolve 
 
2. Film Bias deinterlacing mode for VXP 
 
3. 1080P24sF output available 
 
4. New option to turn off "Flicker Free" interlaced output 
   - Flicker Free is default, when output is interlace rather than 
     Progressive, prior to this firmware version 
   - Flicker Free remove flicker when output directly to CRT projector 
     or other device which display interlace signal directly 
 
5. New test patterns "0-255 grey ramps" 
 
6. Additional RS232 control port support, via RS232 to USB converter 
   (which connected to USB port of Crystalio II) 
   - This additional RS232 control port is for PD version of Crystalio 
     II to have external RS232 control of Crystalio II operations AND 
     Crystalio II control of PD projector as the same time 
   - RS232 to USB converter supplied by Pixel Magic Systems separately 
 
7. Significant improvement on firmware upgrade speed (of course user may 
   experience this after this firmware upgrade, but not in this firmware 
   upgrade) 
 
8. Faster auto aspect ratio detection for internal media player 
   (VPS-3800 only) 
 
9. Percent search of media playback for internal media player available, 
   by pressing number keys on the remote control. For example, playback 
   will jump to 20% of the media if "2" key is pressed 
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10. Show (HDCP) on front panel when source is HDCP encrypted 
 
11. Faster profile saving 
 
12. Improved component 1/2 signal detection 
 
13. DynamicVP 1080i conditions now accept timings with any H-Active 
    value (rather than 1920 only) 
 
 
BUG FIXED 
- Minor bug fixed in audio path 
- Saving screen shape with customized resolution 
- Solve video level problem of 0-255 output 
- minor bug fix in hardwired pass-through 
- garbage screen when no signal for some input ports 
- minor bug fixed in macro key processing 
- minor bug fixed in OSD focus bar 
- minor bug fixed in HDMI output 
- bug fixed in HDMI output device name detection 
- Factory Reset/Default Settings also reset media player settings1. Media 
Player integration 
2. Output Brightness/Contrast/Sharpness/Saturation adjustment 
3. Primary Color adjustment 
4. New test patterns "Windowed IRE" 0-100 
5. Test Pattern names relocated (IRE and Pure color patterns) 
6. OSD elements for focus bars updated 
7. OSD layout alignment updated for user defined names 
8. Improved HDMI input port switching 
9. Minor bug fixed in editbox 
10. Quick menu can be invoked inside other quick menu 
11. DynamicVP otherwise cause execution minor bug fixed 
 
Media Player 
Supported file types 
 - DVD (.IFO .ISO) 
 - MPEG2 (.TS .TRP .TP .VOB .M2T .M2P .M2V) 
 - MP3, WAV 
 
Version 1.24 
 
1. Media Player integration 
2. Output Brightness/Contrast/Sharpness/Saturation adjustment 
3. Primary Color adjustment 
4. New test patterns "Windowed IRE" 0-100 
5. Test Pattern names relocated (IRE and Pure color patterns) 
6. OSD elements for focus bars updated 
7. OSD layout alignment updated for user defined names 
8. Improved HDMI input port switching 
9. Minor bug fixed in editbox 
10. Quick menu can be invoked inside other quick menu 
11. DynamicVP otherwise cause execution minor bug fixed 
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Media Player 
Supported file types 
 - DVD (.IFO .ISO) 
 - MPEG2 (.TS .TRP .TP .VOB .M2T .M2P .M2V) 
 - MP3, WAV 
 
Limited supported file types 
 - MPEG4 (.MP4 .M4P .M4V) 
 - MPEG1 (.MPG .MPEG .DAT .M1V) 
   some variations of MPEG1 are not supported 
 
Select a file/folder for copy/move/delete: 
 1. Go to file list 
 2. Move the cursor to particular file/folder 
 3. Press "Menu" button on Media Player remote to highlight the file 
 4. Repeat step 2 and 3 to highlight more files as you wish 
 5. Move the cursor to "Copy"/"Move"/"Delete" button and then press "OK" 
 
 
To use FTP server on C2: 
 1. Power off to standby mode 
 2. connect to C2 with any FTP client on PC. User name and password are 
both "c2ftp". 
 
To setup NFS  
 1. Press "Setup" to go to setup page 
 2. go to System->IP Settings->NFS and then press "OK" 
 3. Enter mount point and IP address 
 4. Move cursor to "Add" in the dialogue box and press "OK" 
 Note: there are 6 slots for NFS mount points. User can select "Prev" 
and "Next" to navigate through the 6 slots. 
 
Others operations 
  Please refer to HD Media Box user manual 
 
Notes 
  - Support USB external storage. 
   (Partition Format: PC; File system:FAT32,EXT2,UDF,NTFS(read only)) 
  - Support UTF-8 encoded file name. (Chinese/Japanese/KoreanWestern) 
  - Support auto aspect ratio for DVD and MPEG2 media 
 
Version 1.23 
1. Macro Definitions 

Overview: 
Macro feature lets user to redefine the functions of the C2 remote key. 
By default, each key in the C2 remote has a specific function which is 
pre-defined, user can use the Macro feature to override the functions of 
each of the key. 
 
Using Macro: 

- Advanced Option must be turned on first. 
- Go to System --> Macro to display the Macro Definition page of 

the OSD. 
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In the Macro Definition page, all the keys that can be redefined are 
shown according to its location on the remote control. 
In order to redefine the function of a key: 

- Select the key in the Macro Definition page and press OK. 
- Then, the Macro Definition edit page is shown for that key. 
- In the Macro Definition edit page, user can assign the name 

of the macro in the "Macro Name" field. 
- The function of the Key can be specified by a list of ordered 

commands (max. 10). Commands can be selected by firstly 
select a "Groups", and then select a "Subgroups", and finally, 
select a command from the "Command" combo box. 
(Since there are so many commands (over 180) in C2 that 
can be selected in Macro Definition, commands are grouped 
into groups and sub-groups for easy selection) 

- If a macro is defined for a key, as the key is pressed, the 
specified commands will be executed one by one.  Notes: 
execution of commands will be stopped if an OSD setup 
command is executed in the macro. 

 
Virtual Key: 

- In the Macro Definition page, there is a button labeled "Virtual 
Keys" at the lower right corner. As this button is selected, 20 
virtual keys are shown in the "Macro Virtual Key Definition" page. 

- User can select the virtual keys and define its function as normal 
remote keys. 

- Virtual Keys are remote key that are not in the C2 remote, but 
can be programmed into other remote controls. The remote key 
codes are as follow: 
VK00 - 0xb94627d8 
VK01 - 0xb84727d8 
VK02 - 0xb74827d8 
VK03 - 0xb64927d8 
VK04 - 0xb54a27d8 
VK05 - 0xb44b27d8 
VK06 - 0xb34c27d8 
VK07 - 0xb24d27d8 
VK08 - 0xb14e27d8 
VK09 - 0xb04f27d8 
 
VK10 - 0xda2527d8 
VK11 - 0xd92627d8 
VK12 - 0xd82727d8 
VK13 - 0xd72827d8 
VK14 - 0xd62927d8 
VK15 - 0xd52a27d8 
VK16 - 0xd42b27d8 
VK17 - 0xd32c27d8 
VK18 - 0xd22d27d8 
VK19 - 0xd12e27d8 

 
MediaPlayer (VPS3800 only): 
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- If input source is MediaPlayer, Macro Definition edit page is 
different.  User can specify the selected C2 remote key to act as 
a MediaBox remote key. 

 
2. Import/Export of profiles and settings 

There are two ways of Import/Export settings: 
 
2.1. System --> Import/Export Settings 

As "Import/Export Settings" is selected, the "Import/Export 
Settings" page is shown on OSD. 
User can select which types of settings (can be multiple 
selections) will be imported or exported. 
Then select the "Export" button to export the selected settings. 
Or, select the "Import" button to import the selected settings. 
 
Note: When Import or Export the settings, an USB thumb drive 
must be plugged in the USB port at the end of C2 first. 
 
This way of Import/Export will import or export all the data 
(current settings and all profiles) of the selected type. 

 
2.2. Profile --> Advanced Import/Export 

If Advanced option is turned on, there will be two more buttons 
labeled "Advanced Import" and "Advanced Export" at the lower 
right corner of each of the Profile OSD page (Input Profile, 
Output Profile, Video Profile and Secondary Passthru Profile). 
By this feature, user can import or export individual profiles. 
Advanced Export: 

- In the "Advanced Export" OSD page, user can select 
which profiles will be exported by checking the check list, 
and then press the "Export" button to export the selected 
profile. 

Advanced Import: 
- The USB thumb drive that contains the exported profiles 

must be plugged into the USB port first before "Advanced 
Import" page can be shown. 

- In the "Advanced Import" OSD page, the profiles which is 
in the USB thumb drive will be listed.  User can then 
select which profile is imported into which profile slot in 
the system.  Then, press the "Import" button to import the 
profile. 

 
3. New front panel LCD command "System"->"Control OSD", to invoke 

OSD by front panel LCD 
 
4. New front panel LCD command "Input"->"Port Config"->"HDMI"-

>"Cable Eq.", to match HDMI cable length 
 
5. Show user defined port names in quick selection menu 
 
6. Minor bug fixes on secondary pass-through 
 
7. Remote Control Repeat Delay, set to 26 to disable repeat key 
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Warning: Input profile may lose after firmware upgrade, please write down the 
important settings if needed. 
 
Version 1.21 
1. Secondary pass-through available. To configurate, goto OSD pass-

through page (make sure System -> Advanced Option is ON). 
 
2. Customizable NLS aspect ratio 
 
3. "Front Panel" command group under front panel "System" commands, 

including the following sub-commands: 
- LED Lights (OFF, Active) 
- LCD Lights (OFF, Active, ON) 
- LCD Contrast (-5 to +5, default is 0) 
- Room to Room (OFF, ON) 
- Remote Control Repeat Delay (1 to 25, default is 6) 

 
Note that when Room-to-room control is ON, the front panel remote 
control will be disabled. 

 
4. Three new commands added in front panel system command group: 

- "Power-up action", user can select "Standby" or "Normal", which 
means Crystalio will run into Standby mode or Normal running 
mode after it is connected to power supply 

- "Network" for setting the IP address and subnet mask 
- "System Restart" to force system reboot 

 
5. Customizable 1080i output resolution 
 
6. Enhancement of input signal detection 
 
7. Handling of screen blackout problem for HDMI output 
 
8. Bug fixed for 480p pass-through 
 
9. Minor bug fixed on Aspect Ratio / Screen Shape 
 
Version 1.19 
1. Improved HDMI input/output audio handling 
 
2. Improved HD-SDI detection 
 
3. DynamicVP - "otherwise" condition execution optimized 
 
4. Power on/off command added into RS232 command list 
 
5. Scart mode updated 
 
6. 1080i supported refresh rate confined to 59.94Hz or 50Hz 
 
7. New option to force HDMI output port to run in DVI mode 
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8. HDMI output device name detection added 
 
9. Default audio port mapping updated 
 
10. Overheat sluggish problem solved 
 
11. "Video Profile" dimmed in software pass-through mode 
 
12. 2048 horizontal active lines test pattern bug fixed 
 
13. Component 1/2 input overscan problem fixed 
 
14. SDI polarity bug fixed 
 
15. RGBS image position bug fixed 
 
16. RGBS video level bug fixed 
 
17. OSD bug fixed: Digital Audio 1 is Optical 
 
Version 1.18 
1. Output timing updated 
 
2. Minor bug fix on Y/C delay 
 
3. HDMI1/2 output force to DVI mode on front panel 
 
Version 1.17 
1. RS232 control 
 
2. New DynamicVP conditions: When Film / When Video 
 
3. DynamicVP sensitivity updated 
 
4. Factory Reset / Default Settings updated 
 
5. Hardware status detection updated 
 
6. Bug fix of composite input polarity 
 
Version 1.16 
1. New test patterns 
 
2. Next/Prev test pattern by left/right arrow key 
 
3. Test pattern color switching by up/down key 
 
4. New DynamicVP conditions for Film/Video source detection 
 
5. RGBS SCART update for SD Analog in 
 
6. HDCP handshaking improved 
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7. Component color space configuration updated 
 
8. Speed up image profile recall 
 
9. Speed up DynamicVP execution 
 
Version 1.15 
1. Fixed OSD status message when changing resolution by using front 

panel 
 
2. Fixed screen splitting problem 
 
Version 1.14 
1. HDMI output device detection modified  
 
2. Shorten startup initiation time 
 
Version 1.13 
1. improved gamma accuracy 
 
2. Input color space detection problem fixed  
 
3. HDMI output control detection / data transmittion timing adjusted 
 
Version 1.12 
1. 480p/576p input to component 1/2, horizontal resolution shown 

corrected 
 
2. Reset hot plug device after HDMI input channel switched 
 
3. HDMI 1 output forced to DVI mode (For PD version only) 
 
4. Apply output gamma when switching major output port or recalling 

output profile 
 
5. Bug fixed: unable to find upgrade file in some unusual situations 
 
6. Problem of 800x600 input to component 1/2 fixed 
 
7. Resolution timing detail shown on OSD corrected 
 
8. Resolution name generation bug fixed 
 
9. Added input/output description in Executing DynamicVP message 
 
10. New command "System Info" in front panel system command group, to 

show the firmware versions, IP address and hard disk status. 
 
Version 1.11 
1. When switching to digital audio input, mute analog audio output until 

signal verified supported by analog audio output 
 
2. HDMI output apply pixel replication if pixel rate <= 25MHz 
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3. Not sending power ON/OFF to PD projector (for PD firmware only) 
 
4. Solved problem of showing default picture when Media Player 

(available on VPS-3800 only) is current input source 
 
5. Solved problem of occasionally loss of user settings after firmware 

upgrade 
 
Version 1.10 
1. Four Stages Gamma Correction 

- Input/Output stage gamma correction 
- Overall and/or RGB channel separated gamma correction 
- User adjustable gamma curve for all 4 stages 

 
2. Two new image aspect ratio added 

- 16:9 Letter Box / 1.85:1 
- 16:9 Letter Box / 2.40:1 

 
3. Fully disable HDMI input port when it is not active 

- This solves the problem that some video players may refuse to play 
encrypted source if HDMI connected but unable to establish HDCP 
linkage 

 
4. HDMI audio output issue resolved 
 
5. HDCP issue (when DCDi turned ON) resolved 
 
6. OSD status messages for user defined port names refined 
 
7. Software video pass through to analog output problem resolved 
 
8. Aspect ratio quick menu realigned 
 
9. Faster OSD information page update 
 
 


